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Duration of the program: Forty-eight (48) hours over twelve (12) weeks period,  
September 14-December 14, 2019 

                            

                     WEEK 6: Saturday: October 19, 2019, 9:00 AM to 1:00 PM 

 

Course 6: Development and Construction 
 

Presenters:  

09:00  Welcome        Taylor Smith, Project Coordinator, Monroe Neighborhood Revitalization  
           Program    
 
09:05  Intro. to Speaker     Eric Porter, Program Founder, ComNet, LLC                                                                                                   
 
09:10  Build-A-Home    Aaron Patton, Jr. CEO, Build-A-Home, Building Supplies, Natchez, MS 
 
10:10  Coffee Break/Stretch 
 
10:20  Intro. to Speaker       Eric Porter, Program Founder, ComNet, LLC  
 
10:25  QuickBooks                                           Achilles Williams, CPA,  
           1st Generation Certified Sustainable Neighborhood Developer 
 
12:45  Program Review      Sung No, SU EDA Center 
   
12:50  Closing   Remarks      Ellen Hill, Head, Planning & Urban Development, City of Monroe, LA 
 
01:00 Dismissal         



Build-A-Home, 

LLC
More Than Just Hardware



About Us

Family & Minority Owned 
Hardware & More Store

Established in 2018

Located in Historic 
Natchez, MS



What We 

Offer

Home & Farm Hardware Supplies

Lumber

Flooring

Furniture & Appliances

Lawn & Garden



More of What 

We Offer

Building Materials

Hand & Power Tools

Paint & Sundries

Plumbing & Heating Supplies

Electrical Supplies



Just A Little 

More of What 

We Offer

SPORTING GOODS 
& OUTDOOR 

LIVING

AUTOMOTIVE 
SUPPLIES

HOUSEWARE & 
HOUSEHOLD 

SUPPLIES

BLUEPRINT 
TAKEOFF 
SERVICES

DELIVERY TO SITE 
SERVICES (FEES 

APPLY)



Our Store Stocked Products



Building Supplies



Lawn & Garden And Automobile



Furniture & Cabinetry



Gardening & Houseware



Paint



Pets Supplies 



How Can We 

Help You??

Provide You With Access To Over 
55000 Warehouse Products Via 
Our Website: mybuildahome.com

Provide Superior Customer 
Service

Deliver On Time



Can I Count 

On You To 

Use Our 

Products

Remember We Have over 55,000 
Products Available

Yes, We Delivery To Monroe & 
Surrounding Areas

24/7 Access With The Ability To 
Purchase Right On Our Website 

Access To Yours Truly



Questions



Published by Dr. Lynda Batiste

lynbatiste@yahoo.com

QuickBooks Simplified: 

Introduction

Presented by Achilles William, CPA, 

1st Generation Certified Neighborhood 

Developers



FACT 1:

One of the most important things to 

remember when using QuickBooks 

to organize and maintain business

finances is that software alone 

cannot do the job. 

How you use the software is what 

really determines how accurate 

business financial records will be. 

http://www.ehow.com/business/
http://www.ehow.com/careers/


Today’s you will learn:

 What is QuickBooks?

 Types of QuickBooks Software

 Setting up your company 

 Receiving Money 

 Spending Money

 Common Reports



What is QuickBooks?

QuickBooks is a productivity tool designed to help 
you manage financial information more easily.

This software helps in accounting, bookkeeping and 
managing your income and expenses. 

QuickBooks helps you organize financial accounts 
in one place. 

It allows you to manage bank and credit card 
accounts. You can create charts or reports to track 
your money in each financial account. 



Types

 The four types of QuickBooks 

offer solutions for various size 

and kinds of business.

QuickBooks Enterprise

QuickBooks Premier

QuickBooks Pro

QuickBooks for Mac

http://www.ehow.com/business/




Setting up you company



The EasyStep Interview begins automatically –

don’t ignore it! 

When you create a new company file in QuickBooks 

you are first greeted with the EasyStep Interview 

screen. The interview leads you through all of the 

setup requirements of QuickBooks such as whether 

your business is cash- or accrual-based (check with 

your accountant if you are unsure), whether it pays 

sales tax, has employees, tracks inventory, etc. It’s 

a good idea to go through this interview thoroughly 

at least once for each company file you create. 



Assignment
Compete the basic section of the easy step interview. By completing 

the interview, you will learn what QuickBooks has to offer and how 

you can best customize it for your use. It does not take long. If you 

don’t know the answers to some of the questions, simply accept the 

defaults and move on. You can change your options later through the 

Preferences window.

Revisit the EasyStep Interview by choosing EasyStep Interview 

from the File menu 



Fact

 Most Quickbooks users only 

view the first few screens of the 

EasyStep Interview and then 

leave.

 By doing this, not only have they 

not setup their file correctly, but 

they have not idea of the 

Quickbooks capabilities. If you 

are one of these users, 



The first interview screens will ask for basic information including the name, 

address, contact information and tax id of your business. 

The EasyStep Interview then sets defaults according to your tax and company 

type. When asked for your Company income tax form, be sure to choose the 

correct form. Our sample business is an S Corporation and files Form 1120S.



Then choose your company type from the list given. Choose the type which 

most closely approximates your business, if your exact type is not listed. If your 

business is a nonprofit organization, see our Intro to QuickBooks for Nonprofits 

AppGuide.

The next screen in the EasyStep Interview will ask if you want 

to accept the default Chart of Accounts for your business type. 

Answer YES 



The Chart of Accounts should make bookkeeping a no-

brainer

Open the Chart of Accounts from the Lists menu

QuickBooks will open the default account list created during 

the EasyStep Interview. Your bank accounts, bank balances 

and Opening Balance will depend on what you entered 

during the interview and will probably differ from those shown 

in the figure. 





 The chart of accounts is the core of your 
accounting system. It lists all the types of 
income and expenses you can expect to 
have along with all bank accounts, credit 
cards, loans and other sources of capital to 
be used. Time spent creating a concise 
and complete chart of accounts list 
customized to your organization will be 
repaid manifold come tax and reporting 
time. 

 You can create new accounts, edit existing 
accounts and delete existing accounts from 
the Edit menu while viewing the chart of 
accounts list. To edit or delete an account, 
remember to first select the appropriate 
account. QuickBooks will not allow you to 
delete an account which has already been 
used. However, you can inactivate the 
account by choosing Make Account 
Inactive from the Edit menu.



Edit your Chart of Accounts List by choosing from the 

Edit menu



FACT:

You can alter the chart of accounts at anytime, 
however it’s best to spend time creating an accurate 
list when you first create the file. When reviewed 
critically, your chart of accounts should meet the 
following three requirements. 

First, there should be no redundant accounts. When 
entering a transaction, it should be perfectly clear 
which account is to be used. 

Second, each account should be used for at least 
ten transactions per year. If it is not then you should 
consider making the account more general. 

Third, the chart of accounts list should ideally print 
out on less than three pages. Longer lists are 
cumbersome to scroll through and often contain 
redundant accounts.



Assignment

 Lets complete the set up of your 

company. Which we will use in 

sessions to complete the 

lessons.



Once the interview is 

complete “You’re set”



Follow the powerpoint lessons 

per instruction on

 Receiving Money

 Spending Money

 Common Reports



Receiving Money

As we go through the lesson, be 

creative by designing a customer!!



Invoicing keeps you on top of who owes you money 

Invoices allow you to easily keep track of who owes you money. You should 

create an invoice for a customer or client who owes you money. You may also 

create invoices to keep track of reimbursements owed you.

Choose Create Invoices from the Customer menu 

Fill in the top portion of the invoice as required. Note that we 

used the default Intuit Service Invoice as the Form Template 



Fill in the top portion of the invoice as required

In the Item field, select the Item for which you are invoicing. If it 

is not in the list, type in a general name to describe the item. 

When you click out of the item field, the New Item setup window 

automatically appears. 



When you type in the Item field, the New Item window appears automatically

Choose the item type for this sale; Service items are the easiest to work with. 

You may add a default description which appears every time you use the item on 

an invoice. The description can be changed directly on the invoice if necessary. 

Finally, choose the income account to which the money for this item should be 

assigned. Click OK and you’re returned to the invoice window (next figure). 

After the Amount at the end of the row, there is a Tax indicator column. “Tax” 

signifies the charge is taxable. If it is not taxable, change the indicator for the line 

to “Non”. 

Choose a customer message from the list or type in a new one. A new message 

is saved to the list when you click out of the field. 



FACT

 Make sure that the appropriate 

sales tax is showing on the 

invoice. You should have set 

this up in the EasyStep

Interview. If not, type in a name 

for your sales tax in the sales 

tax field and tab out of the field 

to set up a new sales tax.



Complete the remainder of the invoice

 To print the invoice, click PRINT. To send the invoice by 

email, Click SEND. Clicking the Save & New button 

opens a new blank invoice window after saving the 

invoice. Save & Close simply closes the window.

 You can always find the original invoice listed in Accounts 

Receivable in the Chart of Accounts. Double-click on the 

invoice to see its detail.



Receive Payments for invoices before making a deposit 

If you’ve received payment for an invoice created in QuickBooks, you must 

record the payment against the appropriate invoice before depositing the 

money into the bank.

From the Customers menu choose Receive Payments 



Once you enter the customer name, you should see a Customer 

Balance

If you do not see a balance for this customer, you either did not 

invoice for this money or the customer has already paid. 

Fill in the appropriate fields as shown and make sure there is a 

check mark to the left of the invoice(s) to which you are applying 

the payment.



FACT:
 If you will deposit this money alone into your bank 

account, select Deposit To and the appropriate 
bank account. QuickBooks automatically posts the 
deposit to your bank account. If you plan on 
depositing it with other money you’ve received, 
select Group with other undeposited funds. In this 
case, QuickBooks holds the money in an 
Undeposited Funds account (in the Chart of 
Accounts list) until you manually Make a Deposit



Enter Sales Receipts for on-site sales

 Sales receipts should be recorded for immediate business 

sales, when the customer pays at the time of the sale or 

service. Also, sales receipts may be recorded if you have 

already received money owed for a previous sale, but for 

which you did not create on invoice in Quickbooks.



Sales Receipts are a combination invoice/receive 

payment and are completed as such



Make Deposit is the final step

 Depositing your money into a bank account 

is the final step for receiving funds. If you 

are depositing money resulting directly 

from sales of your service or product, you 

must first ‘receive the payment’ for an 

invoice or ‘Enter a Sales Receipt’



If you have received money for invoices and/or sales receipts and chose to 

group them with undeposited funds, you will see a list of these transactions 

awaiting deposit. Click before each transaction you wish to deposit. A check 

mark will appear before those you have chosen. Click OK.

Click before each transaction you wish to deposit 

The deposit window shows all the payments you checked in 

the previous window (if any). If you forgot to select payments 

in the window above, you may click the Payments button to 

see the window again 



Add any other income directly to the deposit

 Choose the bank account to which the money will be 

deposited from the Deposit to list. Enter the date of the 

deposit. You can now add line items directly to the 

deposit for income that is not business income such as 

rebates, refunds, reimbursements for phone or copier 

usage, transfer from savings or petty cash, etc.



Spending Money



Pay sales tax correctly

 When you record sales income from your business 

into Quickbooks, the sales or gross receipts tax 

portions handled separately since it is not true 

income; it belongs to the government. The sales tax 

owed appears in the Sales tax payable account in 

the Chart of Accounts.  To offset the balance in this 

account properly Quickbooks requires that checks 

written to pay sales tax be handled in a particular 

matter.



 When the Show sales tax due through date field is 

entered, the amount owed appears below. You can 

pay all tax due by clicking in the pay column next 

toe ach tax you will pay. If you wish to pay a portion 

for the tax due, change the amount to be paid in the 

white Amount Paid column.



Enter Bills if you wan to accrue expenses 

Bills reflect how much money you owe to a specific vendor. You can enter bills 

into QuickBooks if you do not plan on paying them immediately, and you wish 

to keep track of how much you owe. If you are going to pay the bill now or do 

not wish to keep track of accruing expenses, there is no reason to enter a bill. 

From the Vendors menu choose Enter Bills 

Fill in the fields according to the information on the bill. In the 

Account column, choose the expense account for this bill 

from the pull down list. Fill in the amount due and a memo if 

you wish. Note that the amount on a bill can be split between 

several accounts by entering more than one line. 





Pay Bills only if you entered bills

From the Vendors menu choose Pay Bills 

Click Show all bills. A window appears listing bills that have 

been entered into QuickBooks but have yet to be paid. If you 

do not see the bill listed which you want to pay, then you did 

not enter the bill to begin with or it has already been paid. 



Click to the left of each bill you want to pay

If you only want to pay a portion of the total amount due, 

change the amount in the Amt To Pay column. If you need to 

view or edit the bill, click on Go to Bill. Be sure to choose the 

correct Payment Account. The Ending Balance shows the 

balance in the account after the selected bills are paid. 



Write Checks to pay someone directly – without entering a bill

The most common way for small businesses to spend money is to write checks. 

If you are writing checks to pay sales or gross receipts tax, refund customers, 

pay employees or payroll taxes

From the Banking menu choose Write Checks 

If you have more than one bank account, make sure the 

correct one appears at the top of the window. Tab through 

each field and fill in the check information as appropriate. 

Under Account, choose the appropriate expense account 

from the drop down list. As with bills, you can split the total 

amount of a check between more than one account by 

entering more than one line. 



Refund Customers properly to account for 

sales tax

 When you refund a customer, you can’t 

simply write a check because sales tax 

must also be refunded. Quickbooks is very 

particular about tracing sales tax. To adjust 

the sales tax owed appropriately, refunds 

must be handled as follows:

 From the customer menu choose Create 

Credit Memo/Refunds



Complete the credit memo form exactly as 

you would an invoice or sales receipt

 Before saving the credit memo, click on 

Check refund



A refund check is automatically created for 

the customer

 Change the check number if necessary and add a memo 

if you’d like, but do not change anything else on this 

check.

 Click Save & Close to post the check to your bank 

register.



Write checks to pay someone directly –

without entering a bill

 From the banking menu choose Write 

Checks



If you do not choose for the check To be printed, type in the 

check number and write the check by hand. Save the check 

by clicking Save & New to write a new check or Save & Close. 

The check will automatically be posted to the appropriate 

bank account in the Chart of Accounts. 



Print Checks or type in check numbers as you 

go

 Under the file menu choose Print Forms -

Checks



 Select the bank account where the checks 

have been posted, enter the first blank 

check numbers to be printed



 Check forms are available in three types:  Standard, 

voucher, Wallet – so you must select the 

appropriate form in the following window.



BRIEF LOOK A PAYROLL
 Payroll can be set up automatically once 

the payroll preference is turned on. (in your 

easy step interview). If not from the Edit 

menu choose preference.



From within the preference window, click on 

the Payroll & Employee icon and chick on the 

Company tab.

 Choose full payroll and any other payroll 

preferences.



Choosing set up payroll from the employee 

window

You can choose a payroll option with Quickbooks payroll 

service:

 Do you pay checks manually, were as you calculate 

employee and company taxes by hand.

 The next option is to sign up for Do-it-Yourself service. 

The updates tax tables are provided by Quickbooks via 

the internet and calculated automatically.

 The third option is to sign up for Assisted payroll service 

which you are provided the Do-it-Yourself service plus 

Quickbooks will file your tax return and other services.

 Complete Payroll acts as an external payroll service. 

Quickbooks provides all payroll service.





Common Reports



From the Reports menu choose Employees & 

Payroll – Payroll Summary. 

From the Reports menu choose Customers & Receivables –

Open Invoices 



From the Reports menu choose Vendors & Payables –

Unpaid Bills Detail 

Bills that have not been fully paid through ‘Today’ are shown by 

default. Change the Date at the top of the window if necessary. 

Double-click on a specific bill to see its detail. Aging of past due 

bills is also shown. Remember that aging is based on the due 

date of the bill, not the billing date. 



FACT:

 Financial Statement are the backbone of your 
business 

 A set of financial statements consists of a Profit & 
Loss Statement (Income Statement), a Balance 
Sheet and occasionally a Statement of Cash Flows. 
Businesses should prepare a set of financial 
statements at least every year. These statements 
are often required by banks, credit card companies, 
vendors and others as proof of your financial status. 
Financial statements also allow you to monitor the 
financial progress of your business, so you may 
want to prepare them on a monthly basis. 



The Profit & Loss Statement (Income Statement) 

The Profit & Loss Statement shows the financial activity of a business during a 

given time period. It provides a dynamic description of income and expenses 

for the period and is the most requested of the three statements. 

From the Reports menu choose Company & Financial – Profit & Loss Standard



The Balance Sheet 

The balance sheet is a static snapshot of your company’s worth on a given 

date. It includes cash balances in your bank accounts, open invoices, unpaid 

bills, payroll taxes you owe, as well as other assets and liabilities you may 

have recorded. 

From the Reports menu choose Company & Financial – Balance Sheet



The Statement of Cash Flows

 Not usually asked for but it gives a dynamic 

picture of the company’s financial growth or 

decline over a certain time period.



 Are there any questions?

Thank You


